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Revision History

The following table lists the revisions of this document.

Table 1: Revision History

Revision Change Description

Revision 01 Initial release.
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Terminology Change

As part of advancing Alcatel-Lucent Enterprise's commitment to racial justice, we are taking a much-needed step
in overhauling ALE engineering terminology to reflect our belief system of diversity and inclusion. Some legacy
products and publications may continue to include terminology that seemingly evokes bias against specific
groups of people. Such content is not representative of our ALE culture and moving forward, ALE will replace
racially insensitive terms and instead use the following new language:

Usage Old Language New Language
Campus Access Points + Controllers Master-Slave Conductor-Member
Instant Access Points Master-Slave Conductor-Member
Switch Stack Master-Slave Conductor-Member
Wireless LAN Controller Mobility Master Mobility Conductor
Firewall Configuration Blacklist, Whitelist Denylist, Allowlist
Types of Hackers Black Hat, White Hat Unethical, Ethical

AOS-W 8.10.0.0 Virtual Appliance Installation Guide 8



Chapter 1

About this Guide

This guide describes the steps to install, configure, and deploy the Mobility Conductor Virtual Appliance or
Mobility Controller Virtual Appliance on:

m vSphere Hypervisor
m  Kemel-Based Virtual Machine (KVM) Hypervisor
m  Windows Hyper-V

The steps to deploy a Mobility Conductor Virtual Appliance and Mobility Controller Virtual Appliance as a standby
Switch or managed device are the same.

For information related to licensing, refer to the Alcatel-Lucent Mobility Conductor Licensing Guide.

Important

The following sections of the guide have references to configuration changes that need to be made when installing
a Mobility Controller Virtual Appliance or Mobility Conductor Virtual Appliance:

= AOS-W VM Requirements
= Assigning Network Connections

Conventions

The following conventions are used throughout this document to emphasize important concepts:

Table 2: Typographical Conventions

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of books.

System items | This fixed-width font depicts the following:

m Sample screen output

m System prompts

m Filenames, software devices, and specific commands when mentioned in the text

Commands In the command examples, this bold font depicts text that you must type exactly as shown.

<Arguments> In the command examples, italicized text within angle brackets represents items that you
should replace with information appropriate to your specific situation. For example:

# send <textmessage>

In this example, you would type “send” at the system prompt exactly as shown, followed by
the text of the message you wish to send. Do not type the angle brackets.

[Optionall Command examples enclosed in brackets are optional. Do not type the brackets.

AOS-W 8.10.0.0 Virtual Appliance Installation Guide 9



Type Style

Description

{Item A |
Item B}

In the command examples, items within curled braces and separated by a vertical bar
represent the available choices. Enter only one choice. Do not type the braces or bars.

The following informational icons are used throughout this guide:

E Indicates helpful suggestions, pertinent information, and important things to remember.

NOTE

/\ Indicates a risk of damage to your hardware or loss of data.

CAUTION

% Indicates a risk of personal injury or death.
WARNING

Contacting Support

Table 3: Contact Information

Contact Center Online

Main Site https://www.al-enterprise.com
Support Site hitps://myportal.al-enterprise.com
Email ebg_global_supportcenter@al-enterprise.com

Service & Support Contact Center Telephone

North America

1-800-995-2696

Latin America

1-877-919-9526

EMEA +800 00200100 (Toll Free) or +1(650)385-2193
Asia Pacific +65 6240 8484
Worldwide 1-818-878-4507

About this Guide |


https://www.al-enterprise.com/
https://myportal.al-enterprise.com/
mailto:ebg_global_supportcenter@al-enterprise.com

HOTE

Chapter 2

Alcatel-Lucent Mobility Conductor Virtual
Appliance

The Alcatel-Lucent Mobility Conductor Virtual Appliance and Mobility Controller Virtual Appliance provide a 64-bit
virtualized software-based managed platform on virtual machine (VM) architecture. The Alcatel-Lucent Mobility
Conductor Virtual Appliance and Mobility Controller Virtual Appliance operate on x86 platforms in a hypervisor
environment and can reside with other virtualized appliances. The Alcatel-Lucent Mobility Conductor Virtual
Appliance and Mobility Controller Virtual Appliance are centralized management platforms for deployment in a
virtualized network infrastructure. Some of the key security features offered by the Alcatel-Lucent Mobility
Conductor Virtual Appliance and Mobility Controller Virtual Appliance are:

= Authentication

= Encryption Support

= Security Policy

m Rogue Detection and Suppression
= Security Firewall

Listed below are few advantages of switching to Alcatel-Lucent Mobility Conductor Virtual Appliance or Mobility
Controller Virtual Appliance environment:

m  Reduces the number of devices occupying rack space and the overheads associated with managing and
servicing products from different vendors.

= Multiple services are consolidated on a common platform, thereby reducing the cost and optimizing the
infrastructure by providing consolidated services.

= Additional devices can be deployed remotely, increasing hardware selection option and flexibility.
m By eliminating a single point failure, you can create a reliable and high-performance networking system.

On successfully installing the Alcatel-Lucent Mobility Conductor Virtual Appliance/Mobility Controller Virtual
Appliance, refer to the AOS-W 8.10.0.0 Getting Started Guide for steps to setup the network.

Ensure the number of CPU sockets is always 1 and the value of the cores is the same as the required CPUs.

VMware’s vMotion can be used to change both compute and storage resources and to migrate virtual machines
between vCenter Server instances. However, these types of migrations are not supported on Alcatel-Lucent Mobility
Conductor Virtual Appliance and Mobility Controller Virtual Appliance.

What's New

This section lists the new features and enhancements released in this version of the installation guide.

AOS-W VM Requirements

Listed below are the minimum resources required for AOS-W VM to function:

If the prescribed vCPU and Memory values are not configured during the initial setup the following error message is
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displayed “Minimum 4GB memory (actual 3GB) or minimum 3 CPU (actual 2 CPU) requirement not met”

For the Alcatel-Lucent Mobility Conductor Virtual Appliance and Mobility Controller Virtual Appliance to function as
expected on a VMware ESXi server with NIC teaming, LACP should be configured and enabled between the VMware
ESXi host and upstream switch.If the prescribed vCPU and Memory values are not configured during the initial setup
the following error message is displayed “Minimum 4GB memory (actual 3GB) or minimum 3 CPU (actual 2 CPU)
requirement not met”. Mobility Conductor Virtual Appliance does not support Nutanix Hypervisor.

Table 4: Memory and CPU Allocation - Mobility Conductor Virtual Appliance

Total vCPU
(hyper Memory (GB) Flash/Disk (GB) Total Supported Interfaces
threaded)
Mobility 3 6 6 2 data ports (0/0/0, 0/0/1), 1
Conductor mgmt port
Virtual
Appliance-50
Mobility 6 8 8 2 data ports (0/0/0, 0/0/1), 1
Conductor mgmt port
Virtual

Appliance-500

Mobility 8 32 32 2 data ports (0/0/0, 0/0/1), 1
Conductor mgmt port

Virtual

Appliance-1K

Mobility 10 64 64 2 data ports (0/0/0, 0/0/1), 1
Conductor mgmt port

Virtual

Appliance-5K

Mobility 16 128 128 2 data ports (0/0/0, 0/0/1), 1
Conductor mgmt port

Virtual

Appliance-10K

NOTE: Alcatel-Lucent recommends using Intel Xeon E5-2650 v4 @ 2.2GHz enterprise grade CPUs for optimum
performance.

If your deployment is using a Mobility Conductor Virtual Appliance 50 SKU and the topology is configured for Layer-2
redundancy, note that the standby Mobility Conductor will be counted as one Mobility Controller against the capacity
and license count.

Table 5: Memory and CPU Allocation - Mobility Controller Virtual Appliance

Total vCPU
(hyper ?/(I;g)lory Flash/Disk (GB) | Total Supported Interfaces
threaded)
MC-VA-10 3 4 6 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

Alcatel-Lucent Mobility Conductor Virtual Appliance |



If your deployment is using a Mobility Conductor Virtual Appliance 50 SKU and the topology is configured for Layer-2
redundancy, note that the standby Mobility Conductor will be counted as one Mobility Controller against the capacity
and license count.

Table 5: Memory and CPU Allocation - Mobility Controller Virtual Appliance

Total vCPU

(hyper ?I(I;Er;r)\ory Flash/Disk (GB) | Total Supported Interfaces
threaded)
MC-VA-50 4 6 6 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port
MC-VA-250 5 8 8 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port
MC-VA-1K 6 16 16 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port
MC-VA-4K 12 48 48 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port
MC-VA-6K 14 64 64 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port
NOTE: Alcatel-Lucent recommends using Intel Xeon E5-2670 v3 @ 2.3GHz enterprise grade CPUs for optimum
performance.

MC-VA-4K and MC-VA-6K are not orderable SKUs. However, you can scale up by installing multiple instances of MC-
VA-1K. For example to deploy 4K APs on a single Mobility Controller Virtual Appliance, you need to add four MC-VA-
1K licenses.

The hypervisor host should not be oversubscribed in terms of number of VMs configured on a host as it adversely
impacts the functionality and performance of AOS-W. In instances where more than one VM is setup in a
hypervisor, then:

= The number of logical processors reported on the hypervisor should be higher or equal to the sum of vCPUs
allocated to each VM setup in that host.

m  The sum of the memory allocated to each VM should not exceed the overall host memory capacity reported.

m Thetotal CPU utilization, memory usage, and network throughput should not exceed 80% of the host
capacity.

Ensure the number of sockets and threads is always one and the value of cores is the same as the current allocation.

AOS-W 8.10.0.0 Virtual Appliance Installation Guide



Chapter 3

Installing AOS-W Using vSphere Hypervisor

Ensure that the following prerequisites are addressed before starting the installation:

m vSphere Hypervisor 6.0, 6.5, 6.7 or 7.0 is installed on the server that hosts the Mobility Conductor Virtual
Appliance/Mobility Controller Virtual Appliance as a guest.

m vSphere Client/vCenter is installed on a Windows machine.

»  OVF/ISO template is obtained from an Alcatel-Lucent representative and accessible from vSphere
Client/vCenter.

The general support for vSphere Hypervisor 7.0 version will be extended till the year 2025 and support for technical
guidance will be extended till the year 2027. Technical guidance for vSphere Hypervisor 6.0, 6.5, and 6.7. version will
be extended till the year 2023.

HOTE

Support for vSphere Hypervisor 5.1 and 5.5 is no longer available.

Logging Into ESXi Host Using vSphere Client

Follow the steps to log in to the vSphere ESXi Host:

Open the vSphere Client.

Enter the IP address or name of the vSphere Hypervisor in the IP address / Name field.
Enter the user name in the User name field.

Enter the password in the Password field.

Click Login.

ok~ b=

The vSphere Client page is displayed.

Creating A VM Network For Management

Follow the steps below to create a VM network for management:

1. Log in to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi
Host Using vSphere Client.

2. From the vSphere Client page, click Inventory.
3. Click Configuration tab.

4. Click Networking from the Hardware menu.
5. Click Add Networking.

The Add Network Wizard is displayed.

AOS-W 8.10.0.0 Virtual Appliance Installation Guide 14



Figure 1 Adding A Network

localhost.Jocaldomain VMware ESXi, 5.5.0, 2068190

Getting Started ' Summary ' Virtual Machines ' Resource Allocation | Performance JeGhifMebhn Local Users & Groups | Events | Permissions

Hardware View: |vSphere Standard Switch

Health Status Networking Refresh |add Networking... | Properties...

Processors

Memory
Storage

VMkamel Port Physical Adapters
L3 Management Network gﬁw vmnicd 1000 Full | E3

Standard Switch: vSwitchd Remove... Properties...

Storage Adapters wmk0 : 10.16.12.27
Metwork Adapters
Advanced Settings
Power Management

6. Select the Virtual Machine radio button and click Next.
7. Select the vSwitch that has VMkernel port mapped for ESXi management network and click Next.

Figure 2 Selecting A Network Adapter For Management

Select which vSphere standard switch will handle the network traffic for this connection. You may also create a new
vSphere standard switch using the undaimed network adapters listed below.

" Create a vSphere standard switch
Intel Corporation 82599EB 10-Gigabit SFP+ Network Connection

 E@ vmnic2 Down Mone
 E& vmnic3 Down Mone
Intel Corporation I350 Gigabit Network Connection
~ B3 vmnic1 1000 Full 0.0.0,1-255,255.255.254

* Use vSwitchD
Intel Corporation I350 Gigabit Network Connection

v EB vmnico 1000 Full 10,16.12,4-10,16.12.4
Preview:
Virbual Machine Port Group — - Phiysical Adapters
WM Network g o BB vmnicl
Management Metwork & 4
vmk0 : 10.16.12.27

8. Inthe Port Group Properties section, provide a name for the management network in the Network Label
field and select All (4095) from the VLAN ID (Optional) drop-down list. Click Next.

Figure 3 Selecting Port Group Properties

Port Group Properties

Metwaork Label: |'u'|'~"| Metwork_Management

YLAN ID (Optional): Mone (0)] ﬂ

Mone vJI[J:.I

Preview:
Virtua| Machine Port Group Physical Adapters
VM Network_Management i E@ vmnico
Wikzme! Port
Management Network i

vmk0 : 10.16.12.27
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9. Click Finish.

E The VM network name is setto VM Network_Management and is used as an example in all configuration procedures.
HOTE

10. Click the ESXi host IP address.

11. Click the Configuration tab.

12. Click Networking from the Hardware section.

13. Click Properties of the VM Network_Management.

Figure 4 VM Network Properties_Management

= [ [10.16.12.27 localhost Jocaldomain VMware ESXi, 5.5.0, 2068190
.
[ Aruba0S_SC_52827_Samp
Getting Started ' Summary ' Virtual Machines ' Resource Allocation | Performance RehifsMeilln Local Users & Groups | Events | Permissions
Hardware View: |vSphere Standard Switch
Health Status Networking
Processors
Memory Standard Switch: vSwitchd Remove...
Storage VMkernel Pore Physical Adsprers
+ Networking {3 Management Network [SX BB vmnicd 1000 Full | §3
Storage Adapters wmk0 : 10.16.12.27
Network Adapters Virtual rt Group
Advanced Settings [ WM Network_Management
Power Management =1 |1 virtual machine(s) | VLAN ID: All (4095)
Aruba0s_SC_52827_Sample &h

14. Select the VM network that was created for management and click Edit.
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Figure 5 Edit Network Properties_Management

Ports lNethrk Adapters ]

Configuration Summary
it vswitch 120 Ports
_& Management Met... vMotion and IP ...
E WM Metwork_Man... Virtual Machine ...

Add... Remove

15. Click the Security tab.
16. Select the Promiscuous Mode check box select Accept from the drop-down list.

17. Select the Forged Transmits check box and select Accept from the drop-down list.

Forged Transmits should be enabled for VRRP to function.

18. Select the MAC Address Changes check box and select Accept from the drop-down list.
19. Click OK.
20. Click Close.

Creating VM Networks For Traffic

Follow the steps below to create a VM network for traffic:
1. Repeat steps 1to 4 of Creating A VM Network For Management.
2. Click Add Networking.
The Add Network Wizard is displayed.
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Figure 6 Adding A Network For Traffic

localhost localdomain VMware ESX|, 5.5.0, 2068190

Getting Started | Summary | Virtual Machines | Resource Allocation ' Performance JeallMElN Local Users & Groups | Events | Permissions

Hardware View: |vSphere Standard Switch
Health Status Networking Refresh Add Networking... Properties...
Processors
Memory Standard Switch: vSuitchd Remove... Properties...
Storage WMkemns! Port Physical Adapters
v Networking 1 Management Network (22 E® vmnicd 1000 Full 2
Storage Adapters wmk0 : 10.16.12.27
Network Adapters Virnuz! Machine Port Group
Advanced Settings 1 VM Network_Management @
Power Management WLAN ID: All (4095)

3. Select the Virtual Machine option and click Next.
4, Select a vSwitch that will handle the network traffic and click Next.

Figure 7 Selecting A Network Adapter For Traffic

G I o

Virtual Machi - Network A
Virtual machines reach netwarks through uplink adapters attached to vSphere standard switches.

Connection Type Select which vSphere standard switch will handle the network traffic for this connection, You may also create a new
Network Access vSphere standard switch using the undaimed network adapters listed below,
Connection Settings ~
Summary {* Create a vSphere standard switch Speed Networks —
Intel Corporation 82599EB 10-Gigabit SFP+ Network Connection
v BB vmnic2 Down Nore
[~ B vmnic3 Down More
Intel Corporation 1350 Gigabit Network Connection E
I~ B vmnici 1000 Full 0.0.0,1-255, 255,255,254
" Use vSwitch0 Speed Networks
Intel Corporation I350 Gigabit Network Connection
[ E@ vmnicd 1000Ful  10.16.12.4-10.16.12.4 -
Preview:
Virtual Machime Port Group Physical Adapters
VM Network gg—cw ymnic2

Help | % Back | MNext = I Cancel |

5. In the Port Group Properties section, provide a name for Network Label and select All (4095) from the
VLAN ID (Optional) drop-down list. Click Next.

Figure 8 Selecting Port Group Properties

T

Virtual Machines - Connection Settings
Use network labels to identify migration compatible connections common to two or more hosts.

Connection Type Port Group Properties
Metwork Access
Connection Settings Metwork Label: I\c'M Metwork_Traffic

Summary VLAN ID (Optional): |m =l

Mone iol

Preview:

Virtual Machine Port Group Physical Adapters
VM Network_Traffic gg-.m wmnic2

Help | < Back | Next = I Cancel
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6. Click Finish.

E Ensure that the Management VM network and the Traffic VM network is isolated to avoid a network loop.

NOTE

7. Click the ESXi host IP address.

8. Click the Configuration tab.

9. Click Networking from the Hardware section.
10. Click Properties of the vSwitch to edit.

Figure 9 VM Network Properties_ Traffic

localhost localdomain VMware ESXi, 5.5.0, 2068190

Getting Started | Summary

Virtual Machines ' Resource Allocation

Hardware

Health Status
Processors

Memary

Storage

Storage Adapters
Network Adapters
Advanced Settings
Power Managameant

Software

Licensed Features

Time Configuration

DNS and Routing

Authentication Services

Virtual Machine Startup/Shutdown
Virtual Machine Swapfile Location
Security Profile

Host Cache Configuration
System Resource Allocation
Agent VM Settings

Advanced Settings

CEG TN Configuration
View: | vSphere Standard Switch
Metworking

Standard Switch: vSwitch0 Remove...
VMkeme! Port Phiysi pters
£7 Management Network: g BB vmnico
vmk0 : 10.16.12.27
Virtuz| Machine Port Group
[ VM Network_Management Q.
= |1 virtual machine(s) | VLAN ID: All {4095)
Aruba0s_sC_52827_Sample &
Standard Switch: vSwitchl Remove.
Virtuz| Machine Port Group — - Physical Adapters
3 VM Network_Traffic Q. x EF) vmnic2
= |1 virtual machine(s) | VLAN ID: All {4095)
Aruba0s_sC_52827_Sample &
Standard Switch: vSwitch2 Remove...
Virtuz| Machine Port Group — - Phiysical Adaptars
3 VM Network_Trafficl Q. x EF) vmnic3
= |1 virtual machine(s) | VLAN ID: All {4095)
Aruba0s_sC_52827_Sample &

Local Users & Groups

1000 Full

[ ropertes..|

Properties...

Properties...

Events ' Permissions

o

!

!

11. Select the VM network that was created for traffic and click Edit
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Figure 10 Edit Network Properties_ Traffic

Forts lNetwork Adapters ]

Port G P ti -
Configuration Summary LEElpR s ] —
@. vawitch 120 Parts MNetwork Label: VM Network_Traffic
g VM Network_Traff.. Virtual Machine ... VLAN ID: All (4095)

Effective Policies
Security
Promiscuous Mode: Reject
MAC Address Changes: Accept
Forged Transmits: Accept
Traffic Shaping
Average Bandwidth: -
Peak Bandwidth: =

m

Burst Size: =

Failover and Load Balancing

Load Balancing: Fort ID
Metwork Failure Detection: Link status only
Motify Switches: Yes

Failback: Yes

Active Adapters: vmnic2
Standby Adapters: None

Add... | Edit... |! Remove Unused Adapters: None il

12. Click the Security tab.
13. Select the Promiscuous Mode check box select Accept from the drop-down list.
14. Select the Forged Transmits check box and select Accept from the drop-down list.

Forged Transmits should be enabled for VRRP to function.

15. Select the MAC Address Changes check box and select Accept from the drop-down list.
16. Click OK.
17. Click Close.

Create two additional networks for traffic and repeat the steps to enable Promiscuous mode and Forged
transmits.

The Mobility Conductor Virtual Appliance supports three network interfaces and Mobility Controller Virtual Appliance
supports four network interfaces. For more information, see Alcatel-Lucent Mobility Conductor Virtual Appliance on

page 11.

If the vSwitch or Distributed vSwitch is configured to use NIC teaming please refer to the Recommendations for

NIC Teaming on a vSwitch on page 63 in the Appendix for validated configuration settings.

Deploying the OVF Template

Follow the steps below to deploy the Open Virtual Format (OVF) template:

1. Log in to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi
Host Using vSphere Client.
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NOTE

2. Click File > Deploy OVF Template.
The Deploy OVF Template Wizard is displayed.

Itis recommended to copy the template to the client machine before importing the OVF template.

3. Click Browse and navigate to the location of the OVA file and click Next.

The OVF Template Details option is highlighted.

4. Click Next.

The Name and Location option is highlighted..

5. Inthe Name field, enter a name for the OVF template and click Next.

The Disk Format option is highlighted.

6. Select Thick Provision Lazy Zeroed option and click Next.

The Network Mapping option is highlighted.

7. Select VM Network_Management from the Destination Networks drop-down list and click Next.
The Ready to Complete option is highlighted.

Figure 11 Network Mapping

Network Mapping
What networks should the deployed template use?

Source

OVF Template Details Map the networks used in this OVF template to networks in your inventory

Mame and Location

Disk Format Source Networks | DestinationNetwarks |
Network Mapping VM Network [vM Netwark_Management ]

Ready to Complet
sady to ompiets VM Network_Management

VM Network_Traffic
VM MNetwork_Trafficl
VM Network_Traffic2

Description:

The YM Network network -

AB

Help | < Back | Mext = I Cancel |

Review your preferences before clicking Finish.

Do not select Power on after deployment check box in the Ready to Complete window.

8. Click Finish.
The OVF template is deployed.

Since the deployment of the OVF template is time consuming, itis highly recommended that the client is on the same
VLAN as the Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance.
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9. Click OK.
10. Click Close.

Pre-Allocating Memory
Follow the steps below to pre-allocate memory in the Mobility Conductor Virtual Appliance/Mobility Controller
Virtual Appliance:

1. Right-click the VM and select Edit Settings or click Edit virtual machine settings from the Getting
Started tab.

2. From the Resources tab select Memory.
3. Select the Reserve all guest memory (All locked) check box.
4. Click OK.

Figure 12 Editing Memory Settings

() Aruba0S_SC_Test - Virtual Machine Pmperties_ =R

Hardware ] Options Resources l Virtual Machine Version: 8
i il s Ll Resource Allocation
CPU 0 MHz
Memary 0 MB | |'7 Reserve all guest memory (All locked) |
Disk Normal
Advanced CPU HT Sharing: Any e |Hormal J | 81920 =
Advanced Memory NUMA Nodes: 2 T ElTE ,ﬁ MEB
iy
Limit: —_— J 60123=] MB
7

A Limit based on parentresource pool or current host

Help [o]'4 Cancel

Repeat the steps to pre-allocate memory for other AOS-W VMs.

For more information on memory and CPU allocation refer to sizing tables in Alcatel-Lucent Mobility Conductor

Virtual Appliance on page 11.

Assigning Network Connections

By default the management network is assigned to all network adapters.

If different networks are not assigned to different adapters it will resultin a network loop.

Follow the steps below to assign different networks to different adapters:
1. Click Edit virtual machine settings.
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Figure 13 Virtual Machine Settings
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applications. An operating system installed on a virtual
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environment, you can use virtual machines as desktop or o
workstation environments, as testing environments, or o = Host
consolidate server applications.

Virtual machines run on hosts. The same host can run ~_ =

many virtual machines. ; “‘Hl

Basic Tasks vSphere Client

[ Power on the virtual machine

G Edit virtual machine settings

2. Select Network adapter2 and select VM Network_Traffic from the Network label drop-down list.

Figure 14 Assigning A Network
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3. Repeat the steps and assign:
a. Network adapter3 to VM Network_ Traffic1
b. Network adapter4 to VM Network_Traffic2
4. Click OK.
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Table 6: Network Adapter Mapping

Adpater Mapping

Network Adapter 1 Out-of-band management
Network Adapter 2 Gigabit ethernet 0/0/0
Network Adapter 3 Gigabit ethernet 0/0/1
Network Adapter 4 Gigabit ethernet 0/0/2

The Mobility Conductor Virtual Appliance does not support more than three network interfaces, but Mobility Controller

oy Virtual Appliance supports four interfaces.

Enabling Security Profile Configuration

This is an optional step and should be used only if serial console redirection is required. To enable security profile
configuration you need to Telnet over the network.

1. Click the ESXi host IP address.

2. Click the Configuration tab.

3. In the Software section, click Security Profile.

4. Inthe Firewall section, click Properties.

5. Select the VM serial port connected over network check box.

Figure 15 Enabling VM Serial Port Connected Over Network
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DNS Client 53 53 UDP,TCP N/ =
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6. Click OK.

Configuring Serial Console for the VM
Follow the steps below to configure serial console for the VM:

1. Select the VM machine that was created.
2. Click Edit virtual machine settings.
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Figure 16 Edit Virtual Machine Settings
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What is a Virtual Machine?

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
applications. An operating system installed on a virtual
machine is called a guest operating system.

Virtual Machines

Because every virtual machine is an isolated computing
environment, you can use virtual machines as desktop or
workstation environments, as testing environments, or to
consolidate server applications.

b‘*:\- Host

Virtual machines run on hosts. The same host can run
many virtual machines.

Basic Tasks vSphere Client

[ Power on the virtual machine

G Edit virtual machine settings

3. On the Hardware tab, click Add.
4. Select Serial Port and click Next.
5. Select Connect via Network and click Next.

Figure 17 Configuring Serial Console
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6. Select Server (VM Listens for connection) and enter telnet://:6001 in the Port URI field.
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Figure 18 Connecting The Serial Via Network

Metwork Serial Port Settings
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7. Click Next > Finish > OK.

To enable serial console redirect refer to Configuring the Initial Setup on page 58.

If there are multiple VMs on the same ESXi host ensure they are connected to different serial ports.

Al

=
=]
-
[l

To access the VM console you must telnet to the IP address of the ESXi host.

I

=
o
-
[l
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Chapter 4

Installing AOS-W Using vSphere Hypervisor
ESXi 6.5

Ensure that the following prerequisites are addressed before starting the installation:

m vSphere Hypervisor 6.5 is installed on the server that hosts the Mobility Conductor Virtual Appliance/Mobility
Controller Virtual Appliance as a guest.

m  OVF/ISO template is obtained from an Alcatel-Lucent representative and accessible from vSphere
Client/vCenter.

Supportis available for vSphere Web Client from ESXi 6.0 onwards.

Overview of Procedures
Listed below are the steps to install AOS-W using vSphere Hypervisor ESXi 6.5:

Logging Into ESXi Host Using vSphere 6.5
Creating a VM Network

Enabling Serial Console Access

Configuring Serial Console for the VM

Logging Into ESXi Host Using vSphere Hypervisor 6.5

Tolog in to the vSphere ESXi host:
1. Enter the IP address of the vSphere Hypervisorin a Web browser.
2. Enter the user name and password.
3. Click Login. The vSphere Web Client page is displayed.

Creating VM Networks

Create two VM networks, one for management and the other for network traffic.

Creating VM Network For Management

To create a VM network for management:

—

. Log into the vSphere 6.5 Web client.

2. Click Networking in the Navigator menu. The networking wizard is displayed.
3. Click Add port group.

4. In Add port group - New port group:

Enter a name in the for the new port group.
Enter 4095 in the VLAN ID field.
Select vSwitch0 from the Virtual switch drop-down list.
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5. Click Add.

6. Select the newly created port group from the networking wizard and click Edit settings.

7. Click the Security tab.

8. Select Accept for Promiscuous mode, MAC address changes, and Forged transmits.
9. Click Save.

Creating VM Networks For Traffic
To create a VM network for traffic:
1. In the vSphere 6.5 Web client navigate to Navigator > Networking. The networking wizard is displayed.
2. Click the Virtual Switches tab.
3. Click Add standard virtual switch.
4. In the Add standard virtual switch - New switch
Enter a name in the for the new virtual switch.

From the Uplink1 drop-down list select a vmnic that will handle the network traffic.
. Click Add.
. Click Port groups in the networking wizard.
. Click Add port group.

0 N O 01 =

. In Add port group - New port group:
Enter a name in the for the new port group. For example Traffic.
Enter 4095 in the VLAN ID field.
m Select the virtual switch that was created for traffic.
9. Click the Security tab.
10. Select Accept for Promiscuous mode, MAC address changes, and Forged transmits.
11. Click Add.

Enabling Security Profile Configuration

This is an optional configuration and should be used only if serial console redirection is required. To enable
security profile configuration you need to Telnet over the network.

1. In the vSphere 6.5 Web client navigate to Navigator > Networking.
2. Click the Firewall rules tab.

3. Select VM Serial port connected over network.

4. Click Actions and select Enable.

Configuring Serial Console for the VM

To configure serial console for the VM:
1. In the vSphere 6.5 Web client navigate to Navigator > Virtual Machines. A list of VMs are displayed.
2. Click the Virtual Switches tab.
3. Right click the VM in which you want to configure serial console and click Edit settings.
4. In the Edit standard virtual switch - <virtual switch name> window:
m Click Add other device and select Serial Port.
m Click the New Serial Port tab and select Use network from the drop-down list.
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m Select Server from the drop-down list for Direction.
m Entertelnet://:6001 in Port URL field.
5. Click Save.
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Chapter 5

Installing AOS-W OVA Using vCenter

Follow the steps below to deploy the Open Virtual Format (OVF) template using vCenter:
1. Login to vCenter.

2. Right-click the ESXi host where the ovf will be deployed and click Deploy OVF Template. This action can
also be done through the Actions > Deploy OVF Template.

3. Select Localfile and click Browse.

4. Navigate to the location of the ova template, select the file, click Open.

5. Click Next.

6. Provide a name for the VM deployment and select the data center that contains the ESXi host. Click Next.

Figure 19 Selecting the Name and Location

¥ Deploy OVF Template i
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5 Select storage
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6 Ready to complete
w [ vcsa.gavm.com
» CJAmMOIl

» 8P

[ Hg Platform-DC

Back HNext Cancel

7. Select the ESXi host to run the deployment. Click Next.
8. Review the details of the deployment and click Next.
9. In the Select storage window ensure Select Thick Provision Lazy Zeroed option and click Next.

10. In the Select network window you can either add a standard vSwitch or distributed vSwitch to the source
network. Click Next and Finish.
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Figure 20 Selecting a Network
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Adding a Serial Port

Follow the steps below to add a serial port to be configured for serial access.
1. Right-click the ESXi where the OVA is displayed and click Edit Settings.
2. Inthe Virtual Hardware tab select Serial Port from the New device drop down and click Add,

3. Make the following changes:
a. For New Serial Port select Use Network.
b. For Direction select Server.

c. For Port URL enter telnet://:<esxi ip address>:<port number>.

4. Click OK and power on the OVA.
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Chapter 6

Installing AOS-W ISO Using vCenter

The following steps summarize the flow of steps to be followed to complete the installation:
1. Download the ISO file.
2. Create a VM running Red Hat Enterprise Linux 6 (64-bit).
3. Edit memory, HDD, network settings, and SCSI controller logic.
4. Edit the VM to force BIOS and use this to change the OS boot from CD.
5. Connect the ISO as CD/DVD from Datastore or local machine.
6. Boot the VM. The VM detects AOS-W from the CD and installs AOS-W.

Create a New VM

1. Download the ISO file from Alcatel-Lucent website and upload the file to the VMware vSphere ESXi
hypervisor datastore.

2. Right-click the ESXi host where the VM will be created and click New Virtual Machine > New Virtual
Machine.

3. Inthe Select a create type window select Create a new virtual machine.
4. Inthe Select a name folder window enter a name for the new VM and select a location. Click Next.

Figure 21 Name and Location of New VM
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Back Next Cancel

5. Inthe Select a compute resource window select the location of the host for installation. Click Next.
6. In the Select storage window select the datastore to store the configuration and disk files. Click Next.
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Figure 22 Select Datastore
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7. In the Select compatibility window, from the drop-down box select the ESXi version running on the
vSphere. Click Next.

8. Inthe Select a guest OS screen, select Guest OS Family as Linux and Guest OS version as Red Hat
Enterprise Linux 6 (64-bit). Click Next.

Figure 23 Select Guest Operating System
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installation.
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Back Next Cancel

9. In the Customize hardware screen make the following changes:
a. Change the CPU value to 6.

Alcatel-Lucent recommends increasing the Cores for CPU and keeping the Socket value always at 1.

b. Click the CPU drop-down and change Cores per Socket to 6.
c. Change the Memory from 2048 MB to 8192 MB.
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Figure 24 Customize CPU, Cores Per Socket, and Memory
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d. Change the New SCSI controller type to LS| Logic Parallel.

e. From the New device drop down select New Hard Disk. Click Add.

f. From the New device drop down select Network and click Add. Add another network for the installation.
The following steps for configuring a serial port is optional:

a. From the New device drop down select Serial Port. Click Add.

b. From the New Serial Port drop down select Use Network and for Connection change Direction to
Server.

c. Configure the Port URI to telnet://:<esxi ip address>:<port number>
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Figure 25 Other Modifications
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Installing the ISO on the VM

1. Navigate to the ESXi host where the VM was installed.

2. Right click and select Edit Settings.

3. Click the VM Options tab and select Boot Options.

4. Select Force Boot Options and Failed Boot Recovery. Click OK.
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Figure 26 Boot Options
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5. Click Power on the virtual machine. The BIOS prompt is displayed.

6. In the Boot option change CD-ROM Dirrive to first boot option and Hard Drive as the second boot option.
Press F10 to save changes and exit.
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Figure 27 Changes to the First Boot Option

-Hard Drive
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7. Navigate to the ESxi host where the VM was installed. Click the Summary tab.
8. In the VM Hardware section, select CD/DVD drive 1 > Connect to CD/DVD image on a datastore.
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Figure 28 Connect the CD/DVD Image on Datastore
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9. Browse to the location of the ISO file in the datastore, select the ISO file and click OK. Verify if the
CD/DVD drive is connected in the Summary tab.

The installation will be initiated and once the installation is complete the system will be halted.

Figure 29 System Halt
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10. Power off the VM and ensure the ISO is removed from the CD/DVD drive in the Summary tab.
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11. Power on the system.
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Chapter 7

Installing AOS-W Using KVM Hypervisor

Prerequisites

Ensure that the following prerequisites are addressed before starting the installation:
= Enabling Intel VT virtualization hardware extensions in BIOS.
= [nstalling CentOS 7.2 on the x86 hardware.

HOTE

HOTE

Issue the ethtool -K ethX gro off command to ensure generic receive offload is disabled for all Ethernet ports that are
mapped to the AOS-W VM for datapath traffic on KVM Hypervisor as root.

Supported Versions
s QEMU 2.0

The host kernel should be running version 4.6 or above and QEMU verision 2.7.0 for optimum crypto throughput
performance with AOS-W in the KVM infrastructre. Libvrt should support passing of poll-us configuration option from
VM xmlspecification to QEMU.

Enabling Intel VT Virtualization Hardware Extensions in the BIOS

Follow the steps below to enable Intel IT virtualization hardware extensions in the BIOS:
1. Power on the machine and access the BIOS Settings.

2. Navigate to the Processor submenu. Processor settings menu may be hidden in Chipset, Advanced CPU
Configuration, or Northbridge.

3. Enable Intel Virtualization Technology.

Installing CentOS 7.2

Follow the steps below to install CentOS 7.2 on your system:
1. Connect a DVD or bootable USB stick to install CentOS 7.2.
. Select Virtualization Host in Software Selection and select all Add-Ons for the installation.
. Click Done.
. Navigate to the location of the CentOS 7.2 file and select the destination folder.
. Click Begin Installation.
. Create a new user and a root password for the CentOS 7.2 installation during the installation process.

N OO oA WDN

. Reboot the server after the installation is complete.

8. Login to the newly installed CentOS 7.2 and configure the network and connect the server to the Intermnet.
A connection to the Internet is required to validate the installation and to install other packages.
a) Check for cpu virtualization support by executing the following command:

[root@localhost ~]# cat /proc/cpuinfo | grep -i vmx flags : .....VMX ......
b) Check for KVM mode support in the Kernel. If kvm_intel is not listed, manually load kvm_intel using the
modprobe kvm_ intel command.
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[root@localhost ~]# lsmod | grep -i kvm
kvm intel 162153 0

kvm 525259 1 kvm intel

[root@localhost ~]#

If the Operation not supported error message is displayed, ensure that Intel Virtualization technology is enabled in the
BIOS.

HOTE

9. Install the following packages:

yum install gemu-kvm-tools.x86_64 gemu-kvm.x86_64 gemu-kvm-common.x86_64
yum install virt-manager.noarch virt-manager-common.noarch

yum install virt-install.noarch

yum groupinstall "GNOME Desktop"

yum install tigervnc-server xorg-x11-fonts-Type1

Follow the steps below to install the AOS-W Mobility Conductor Virtual Appliance or a Mobility Controller Virtual
Appliance on a KVM hypervisor:

1. Configuring the Virtual Network Computing (VNC) Server.
2. Creating a new VM and installing AOS-W.
3. Deploying the Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance.

Configuring the Virtual Network Computing Server

Follow the steps below to configure the Virtual Network Computing (VNC) server and open up the firewall port to
access the server remotely:

1. Start the VNC Server and configure a password for your CentOS server by executing the following
command:

[root@localhost ~]# vncserver.You will require a password to access your desktop.
Password:

Verify:

xauth: file /root/.Xauthority does not exist

New 'localhost.localdomain:1l (root)' desktop is localhost.localdomain:1

Creating default startup script /root/.vnc/xstartup

Starting applications specified in /root/.vnc/xstartup

Log file is /root/.vnc/localhost.localdomain:1.log

2. Open the firewall port on the CentOS server to ensure the CentOS server can be accessed using
vncviewer.

[root@localhost ~]# netstat -ntap | grep vnc

tcp 0 0 0.0.0.0:5901 0.0.0.0:* LISTEN 14318/Xvnc

tcp 0 0 0.0.0.0:5902 0.0.0.0:* LISTEN 5242/Xvnc

tcp 0 0 10.16.9.130:5902 10.20.102.206:51576 ESTABLISHED 5242/Xvnc
tcp6 0 0 :::5901 :::* LISTEN 14318/Xvnc

tep6 0 0 :::5902 :::* LISTEN 5242/Xvnc

[root@localhost ~1#

[root@localhost ~]# firewall-cmd —--permanent —--zone=public --add-port=5901/tcp
success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

3. Download the AOS-W ISO image file from support.esd.alcatel-lucent.com to your CentOS server.

Creating a VM and Installing AOS-W
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Follow the steps below to access the CentOS server through the VNC and start the virt manager to create the VM
to be used by AOS-W:

1. Access the terminal and type virt-manager to start the Virtual Machine Manager.
2. Access the Virtual Machine Manager tab.

3. Click on File > New Virtual Machine. The New VM dialog box is displayed.

4. Select Choose Local Install Media and click Forward.

5. Select Use ISO image and click Browse.

6. Navigate to the location of the iso image and click Choose Volume.

E Ensure that Automatically detect operating system based in install media is not selected.
MOTE

7. Select OS type as Linux and Version as Redhat Enterprise Linux 7.2 from the drop-down lists and click
Forward.

8. Change the Memory (RAM) to 8192 and CPUs to 6 and click Forward.

For Mobility Controller Virtual Appliance the RAM can be setup as 4096 (4 GB) and 3 CPUs. For more information
on memory and CPU allocation refer to sizing tables in the Alcatel-Lucent Mobility Conductor Virtual Appliance on

page 11 section.

9. Select Enable Storage for this VM and change the value in Create a disk image on the computer's
hard drive to 4 GB. Click Forward.

Figure 30 Enabling Storage on the VM

New VM

v Enable storage for this virtual machine

* Create a disk image on the computer's hard drive

‘ 40 - +|GiB

845.0 GIB available in the default location

Allocate entire disk now 'y

Select managed or other existing storage

Browse...

Cancel Back Forward

The size of this disk needs to be at least 4 GB for Mobility Conductor Virtual Appliance/Mobility Controller Virtual
Appliance.

10. Provide a name for the VM and select Customize configuration before install. Click Finish.
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Figure 31 Beginning the Installation
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11. Select VirtlO Disk 1 and click on Advanced Options and make sure the Disk bus option is VirtlO.

12. Click Add Hardware and add another 8 GB storage device. (should be greater than half the size of RAM
configured for the Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance).

13. Select VirtlO from the Bus type drop-down list. Click Finish.
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Figure 32 Adding a Second Storage Device
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Creating Bridge Entries

Create bridge entries to map all three network adapters that you will create in the steps below:

E Ensure that you create a fourth bridge entry when configuring Mobility Controller Virtual Appliance.

HOTE

1. Login to CentOS and create three bridges and map three physical interfaces to these bridges.

[root@localhost
[root@localhost
[root@localhost

[root@localhost
[root@localhost
[root@localhost

[root@localhost
[root@localhost
[root@localhost

2. To make these bridge entries persistent across reboots, create afile in /etc/sysconfig/network-scripts/ for

all bridges.

brctl addbr brl
brctl addif brl
ifconfig brl up

brctl addbr br2
brctl addif br2
ifconfig br2 up

brctl addbr br3
brctl addif br3
ifconfig br3 up

enol

eno?2

eno3

[root@localhost ~]#vi /etc/sysconfig/network-scripts/ifcfg-brl

DEVICE=brl
STP=no
TYPE=Bridge
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IPV6INIT=yes

IPV6_ AUTOCONF=no

IPV6 DEFROUTE=yes

IPV6 FAILURE FATAL=no

NAME=brl
UUID=a65bed46d-a32a-4dca-bd00-f8acf9a356e5
ONBOOT=yes

IPV6 PRIVACY=no

[root@localhost ~]#

[root@localhost ~]1# cat /etc/sysconfig/network-scripts/ifcfg-br2
DEVICE=br2

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6 AUTOCONE=no

IPV6 DEFROUTE=yes

IPV6_FAILURE_FATAL=DO

NAME=br2
UUID=19c£f4539-9633-40aa-a4c5-606849b6e3db
ONBOOT=yes

IPV6_PRIVACY=HO

[root@localhost ~]#

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br3
DEVICE=br3

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6 AUTOCONE=no

IPV6_DEFROUTE=yeS

IPVGiFAILUREiFATALZHO

NAME=br3
UUID=cb%a8df9-aa37-4346-8993-9e3739%9a9%00ce
ONBOOT=yes

IPVGiPRIVACY:nO

3. Click Network Interface and enter the following values:
m  Network Source: Specify shared device name.
m Bridge name: br1
m Device model: virtio
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Figure 33 Creating Bridge Entries
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4. Click Add Hardware to add two more network interfaces.
5. Map bridge interfaces (br2 and br3) to these network interfaces.
6. Click Add Hardware to add serial console.

Enabling Serial Console Over Telnet

Follow the steps below to enable serial console over telnet. This procedure is optional.

1. Remove the existing Serial 1 device and click Add Hardware.
2. Select Serial on the left pane.
3. Select TCP net Console from the Device Type drop-down list.

4. Add the CentOS Server IP in the Host field and change the port number.

5. Select the Use Telnet check box and click Finish.
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Figure 34 Enabling Serial Console Over Telnet
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6. Execute the following command to ensure the host firewall permits access to port number for serial
console.

[root@localhost ~]# firewall-cmd —--permanent --zone=public --add-port=4560/tcp
success

[root@localhost ~]# firewall-cmd --reload
success

Enable serial console redirection from the AOS-W CLI after AOS-W boots up by executing the following command
serial console redirection enable.

7. Select VNC server as the Spice Server from the Type drop-down list.

8. Select Copy local keymap from the Kepymap drop-down list and click Apply.

9. Select CPUs and make select the Copy host CPU configuration option.

10. Select the Manually set CPU topology option from the Topology drop down list.

11. Ensure the number of Sockets and Threads is always 1 and the value of Cores is the same as the value
of Current allocation.
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Figure 35 Configuring CPU Values
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12. Click Begin Installation and select Install AOS-W.

Once the installation is complete the system will be halted after configuring the Mobility Conductor Virtual
Appliance/Mobility Controller Virtual Appliance.

Figure 36 System Halt
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13. Force reset the VM to boot AOS-W and access to first boot dialogue.

Important

m Ensure you open the firewall port from CentOS terminal and restart the firewall.
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HOTE

[root@localhost ~]# firewall-cmd —--permanent —--zone=public --add-port=7001/tcp
success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

Configure Multiple Datapath CPUs

To configure multiple datapath CPU’s additional configuration is required both in host and guest. The guest
changes cannot be made using virt-manager and hence you need to use the virsh edit command.

Ensure that the VM is gracefully shut down by using either the Reboot or Shut Down option before editing the VM xml
specification.

Figure 37 Graceful Shutdown
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Changes in Host

On the KVM server, load the vhost_net module
[root@localhost ~]# lsmod | grep vhost
[root@localhost ~]# modprobe vhost net
[root@localhost ~]# lsmod | grep vhost

vhost net 18152 O

vhost 33338 1 vhost net
macvtap 22363 1 vhost net
tun 27141 3 vhost net

XML Changes in Guest

Use the virsh edit <name of the VM> command in the KVM server and add the <driver name="vhost'
queues="y'/>” tag, where y = total number of CPU'’s allocated to the VM.

For example, for a VM with six VCPU’s and three NIC’s of type Virtio, edit the xml and add <driver

name="vhost’ queues='6"> “ tag for each NIC interface.
aruba@ubuntu-server-16x:~$ virsh list --all

Id Name State
5 centos6.5 running
- vmm-500dev shut off

[root@localhost ~]# virsh edit vmm-500dev
Domain vmm-500dev XML configuration edited.

Add <driver name="vhost' queues="'6'/> after “model type="virtio’” in the bridge config to ensure the values for
the number of queues for the vhost and CPUs for the VM are the same.

The following snippet is an example of multi-queue XML specification for a single NIC interface. The same tag

needs to be added for all Mobility Conductor Virtual Appliance NIC interfaces.
</controller>
<interface type='bridge'>
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<mac address='52:54:00:d3:4a:3c'/>

<source bridge='brl'/>

<target dev='vnetl0'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net0'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x03' function='0x0"'/>
</interface>

<interface type='bridge'>

<mac address='52:54:00:49:7a:c6'/>

<source bridge='br2'/>

<target dev='vnetll'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='netl'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x04' function='0x0"'/>
</interface>

<interface type='bridge'>

<mac address='52:54:00:d3:55:7d"'/>

<source bridge='br3'/>

<target dev='vnetl2'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net2'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x05' function='0x0'/>
</interface>

[root@localhost ~]# virsh edit vmm-500dev

Domain vmm-500dev XML configuration edited.

[root@localhost ~]# virsh dumpxml vmm-500dev | grep queues
<driver name='vhost' queues='6"'/>

<driver name='vhost' queues='6"'/>

<driver name='vhost' queues='6"'/>

[root@localhost ~1#

Reboot the VM and once the VM boots up you should see three CPUs as indicated in the example
(mm) [mynode] #show datapath utilization
Datapath Network Processor Utilization

- fo——— fomm fomm tmmm +

| Cpu | Cpu utilization during past |

| Type | Id | 1 Sec 4 Secs 64 Secs |
Fo———— Fo——— Fomm fomm e +

SP | 1] S | S | 0% |

FP | 2 | 0% | 0% | 0% |

FP | 3 S | 0% | 0% |
Datapath CPU Allocation Summary

Slow Path (SP) : 1, Slow Path Gateway (SPGW) : O
Fast Path (FP) : 2, Fast Path Gateway (FPGW) : O
DPI : 0, Crypto (CRYP) : O

(mm) [mynode] #

VM memory locking xml tag

<name>VMC 50</name>
<uuid>4f5aaac7-7c3c-4565-8bf3-1b1492945cde</uuid>
<memory unit='KiB'>6291456</memory>
<currentMemory unit='KiB'>6291456</currentMemory>
<memtune>
<hard limit unit='G'>8</hard limit>
</memtune>
<memoryBacking>
<locked/>
</memoryBacking>
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Chapter 8

Installing AOS-W Using Windows Hyper-V

Prerequisites

Ensure that the following prerequisites are addressed before starting the installation:
= Hyper-V Version Windows Server 2012 R2
m  Hyper-V Version Windows Server 2016

The following procedure can be used to deploy a Mobility Controller Virtual Appliance or a Mobility Conductor Virtual

NoT o Appliance on Windows Hyper-V.

Installing AOS-W on Windows Server Hyper-V

1. Log into the Windows server.

2. Open the Hyper-V manager.

3. Select the Hyper-V host machine from the navigation pane.

4. Right-click on the host machine and click New > Virtual Machine. Click Next.

Figure 38 Creating a New VM
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5. Enter a name for the VM in Specify Name and Location screen. If you want to store the machine in a
location different from the default one, select the Store the virtual machine in a different location
checkbox.

6. Select Generation 1 as generation for this VM. Click Next.

7. Allocate 4096 MB as the startup memory. Click Next.

8. Click Next on the Configure Network screen. Network will be configured in later steps.

9. Enter a name for the first virtual disk. A second virtual disk will be added in later steps. Click Next.
10. Select Install an operating system from a bootable CD/DVD-ROM.

11. Select Image file (.iso) and click Browse to navigate to the location of the iso file. Select the iso file and
click Next.

12. Click Finish.

Figure 39 Completing the Installation
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< 1] >

To create the virtual machine and dose the wizard, dick Finish.

=] [

Configuring the New VM

1. Right-click on the new VM and click Settings.

2. Select Processor from the Hardware pane and set the Number of virtual processors based on your
requirement. For more information see, Alcatel-Lucent Mobility Conductor Virtual Appliance on page 11.
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Figure 40 Virtual Processor Settings
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3. Click IDE Controller 0. Select Hard Drive and click Add to add a second hard drive.

For increased performance itis recommended to use a SCSI controller/Disk instead of IDE controller.

4. Click New.
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Figure 41 Adding a Second Virtual Disk

] Settings for New Virtual Machine_Test on WIN-6VM31190<1? [— [C X
||\|sw Virtual Machine_Test v| L | 3 ";
2 Hardware A s Hard Drive
¥ Add Hardware
& BIOS You can change how this virual hard disk is attached to the virtual machine. If an
S operating system i instaled on this disk, changing the attachment might prevent the
o vir twal machine from starting,
- Niemorv Controller: Locaton:
@ [ Proceseor IDE Controller 0 v|[1(nuse) v
K Iriua processors Medm
= & IDE Controller 0 You can compact, convert, expand, merge, reconnect or shrink a virtual hard cisk

® (# Hard Drive by edting the associated file. Specify the full path to the filke.
MC Disk1_Test.vh ® Vitual hard disc:
+ (s Hard Drive
<file> |
= B 1DE Conmoler 1 New B
¢* CVD Drive GpEe

® sCsI Controller
® § Network Adapter

@ 1f the physical hard disk you want to use is not listed, make sur= that the

F com1 disk is offine. Use Disk Management on the physical computer to manage
None physical hard disks.

F com2
Neane To remove the virtual hard ask, dick Remove. This disconnects the disk but does not
o delete the assodated file.

f=) Diskette Drive

£ Management

L MName

¥ Integraton Services

& | Checkpoint Tile Location

25 Smart Paging Fie Location
C:\ProgramData \Microsoft\Win v

[ o [ cace [ o

5. Click Next in the New Virtual Hard Disk Wizard window.

6. Select VHDX as the disk format and click Next.

7. Select Dynamically expanding as the disk type. Click Next.
8. Specify a name and location for the new VM and click Next.

9. The size of the new VM should be at least the size of the RAM. For more information on the size of the hard
disk, see Alcatel-Lucent Mobility Conductor Virtual Appliance on page 11. Click Next > Finish.

In the Hardware > Processor section of the VM ensure the Maximum number of processors and the Maximum amount
of memory on a single virtual NUMA node in the NUMA topplogy should always be more than the values configured
for the Mobility Conductor. If the number of processors or memory allocated to the Mobility Conductor is more than
what s configured under the NUMA configuration, the number of NUMA nodes and sockets will automatically
increase and Mobility Conductor will not boot up.

Creating a Network Adapter

1. Select Add Hardware from the Hardware pane.
2. Select Network Adapter and click Add.
3. Select a virtual switch from the drop-down list.
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4. Select Hardware Acceleration and ensure that Enable virtual machine queue and Enable IPsec task
offloading check-boxes are cleared.

5. Select Advanced Features and complete the following steps:
a. Check the Enable MAC address spoofing checkbox.
b. Disable Protected Network.

Figure 42 Advanced Features
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MAC address spoofing allows virtual machines to change the source MAC
address in outgoing packets to one that is not assigned to them.

[¥] Enable MAC address spoofing

DHCP guard

DHCP guard drops DHCP server messages from unauthorized virtual machines
pretending to be DHCP servers.

[ "] Enable DHCP guard

Router guard

Router guard drops router advertisement and redirection messages from
unauthorized virtual machines pretending to be routers,

[] Enable router advertisement guard

Protected network

Move this virtual machine to another duster node if a network disconnection is
detected.

|| Protected network

Port mirroring

Port mirroring allows the network traffic of a virtual machine to be monitored by
copying incoming and outgoing packets and forwarding the copies to another
virtual machine configured for monitoring.

ore J

Mirroring mode:

Settings for New Virtual Machine_Test on WIN-6VM9II190K1P

|NewvirtuaIMachine_Test vid b G
% Hardware ~ | Advanced Features -

U Add Hardware

& BIOS MAC address

t fro ®) Dynamic

™ Memory ) Static

# [ Processor 00 (| 00 |-| 00 |-[ 00 |-| 00 || 00

| o Cancel

| |

Apply

6. Click Apply > OK.

Mobility Controller Virtual Appliance.

Create 3 network adapters for deploying a Mobility Conductor Virtual Appliance and 4 network adapters for deploying

7. Right-click the new VM and click Start.

8. Turn off the VM after the installation is complete and remove the installation ISO from DVD Drive. Restart

the VM.
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Figure 43 Restart the VM
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To configure remote serial console for the VM, use a third party TCP proxy tool.

Configuring Trunk Ports

Run the following PowerShell commands to configure trunk ports:

m Remove all network adapters from the VM:

Remove-VMNetworkAdapter -vmname VMC

m  Add mgmt interface;

Add-VMNetworkAdapter -VMName VMC -Name mgmt
Set-VMNetworkAdapter -VMName VMC -Name mgmt -IPsecOffloadMaximumSecurityAssociation 0
-VmgWeight 0 -NotMonitoredInCluster S$true

m Add data interfaces:

Add-VMNetworkAdapter -VMName VMC -Name pl
Set-VMNetworkAdapter -VMName VMC -Name pl -IPsecOffloadMaximumSecurityAssociation 0 -
VmgWeight 0 -NotMonitoredInCluster S$true -MacAddressSpoofing on
Set-VMNetworkAdapterVlan -VMName VMC -VMNetworkAdapterName pl -Trunk -
AllowedVlanIdList "1-4094" -NativeVlanId O

Repeat the commands to create 2 virtual NICs if the device used is a Mobility Conductor Virtual Appliance or 3 virtual
NICs if the device is a Mobility Controller Virtual Appliance.

These interfaces can then be added to virtual switches added through Ul.
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Chapter 9

Post-Installation Procedures

Once the installation is complete, follow these post-installation procedures to complete the deployment.

Configuring the Initial Setup

Follow the steps below to configure initial setup:

1
2

. Click Power on the virtual machine.
. Enter values for the following first boot parameters in the console:
System name
Switch role
IP type to terminate IPsec tunnel
Conductor switch IP address or FQDN
Is this a VPN concentrator for managed device to reach Conductor switch
This device connects to Conductor switch via VPN concentrator
Conductor switch Authentication method
IPsec Pre-shared Key
Uplink Vlan ID
Uplink port
Uplink port mode
Native VLAN ID [1]
Uplink Vlan IP assignment method
Uplink Vlan Static IP address
Uplink Vlan Static IP netmask
IP default gateway
DNS IP address
IPV6 address on vlan
Port-channel
Port-channel id
Uplink Vlan Static IPv6 address
Uplink Vlan interface IPV6 prefix length
IPv6 default gateway
Country code
Time Zone
TimeinUTC
Date
Password for admin login
Re-type password for admin login
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HOTE

The choices you entered in the first boot dialog are displayed.

Enter a static IP as the management IP in VLAN as part of the Mobility Conductor Virtual Appliance/Mobility Controller
Virtual Appliance setup. This should be a routable IP in an accessible subnet that the user can use to access the
Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance via CLI (SSH) or Web GUI (HTTP) after

VM setup is complete.

Enter <Ctrl P> to make changes to the first boot parameters.

3. Enter Yes to accept the changes. The Mobility Conductor Virtual Appliance/Mobility Controller Virtual
Appliance reboots and displays the log in prompt.

4. Log in with user name as admin and the password set in Step 2.
5. Execute the enable command.

6. Power on the Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance and execute the
following command to enable the serial console.

NOTE

HOTE

HOTE

Serial console redirect requires the vSphere Enterprise Plus license. When you enable serial console redirect, the
vSphere console host window will be blank.

(host) #serial console redirect enable

Execute the following command to see the status of the serial console.
(host) #show serial console redirect
Serial Console Redirect : Enabled

Execute the following commands to disable and view the status of the serial console.
(host) f#serial console redirect disable

(host) #show serial console redirect
Serial Console Redirect : Disabled

Reboot the Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance to access the serial console
after enabling the serial console redirect.

To access the serial console telnet the IP address of the serial console followed by the serial port configured. For
example: telnet 10.16.12.27 6001.

Management Interface

The Mobility Conductor Virtual Appliance/Mobility Controller Virtual Appliance is a VM instance and access to the
console is dependent on the deployment environment. If access through the serial port is denied you can
alternatively access the console through the Management Interface. After an IP is assigned, the management
interface can be accessed from anywhere in the network. To implement this change a separate routing table is
assigned with its own default gateway for managing the IP that is introduced. This ensures the management
traffic is routed to the right interface.

The initial implementation of this feature covers IPv4, IPv6, and manual configuration of a static IP for
management interface from the console.

This feature cannot be configured using the WebUI.

Execute the following commands to configure an IP on the management interface:

IPv4:

(host) [mynode] #configure terminal
Enter Configuration commands, one per line. End with CNTL/Z

Post-Installation Procedures |



(host) [mynode] (config) #interface mgmt
(host) [mynode] (config-submode)#no shutdown

(host) [mynode] (config-submode)#ip address 10.16.9.203 255.255.255.0

IPv6:

(host) [mynode] (config) #interface mgmt
(host) [mynode] (config-submode)#ipv6 address 2014::184/64

Execute the following commands to configure a default gateway for the management interface traffic and to
segregate the management traffic from the normal data traffic on datapath ports:

IPv4:
(host) [mynode] (config) #ip default-gateway mgmt 10.16.9.2

IPv6:
(host) [mynode] (config) #ipv6 default-gateway mgmt 2014::1
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Chapter 10

Troubleshooting

Connectivity Issues

Users experience wireless client connectivity issues when Mobility Conductor Virtual Appliance and Mobility
Controller Virtual Appliance is used with NIC teaming and without configuring LACP. To resolve this issue refer to
in the Appendix.

DHCP Address

Clients connected to the Alcatel-Lucent Mobility Controller Virtual Appliance are unable to get a DHCP address.
This issue is resolved by implementing NIC teaming on vSwitch or Distributed vSwitch. For more information
refer to the Appendix.

ARP Issues

ARP issue occurs when Promiscuous Mode is not enabled and all VLANSs are disallowed on vSwitch.

Instructions

Enable Promiscuous Mode and allow all VLANs on vSwitch.
To enable Promiscuous Mode, perform the following steps:
1. Log in to vSphere ESXi Host.
2. Switch to Configuration tab.
3. Select Networking under Hardware section.
4. Click Properties for a configured vSwitch.
5. Click Edit under Ports tab of vSwitch Properties window.
6. Switch to Security tab in vSwitch Properties window.
7. Select Accept from the Promiscuous Mode drop-down list.

Enable Promiscuous Mode on all ports attached to the VM. If a single portis used in AOS-W, Promiscuous Mode need

not be enabled.
HOTE

8. Click OK.
To allow all VLANs on vSwitch, perform the following steps:
1. Log in to the vSphere ESXi Host.
2. Click the Configuration tab.
3. Select Networking under Hardware section.
4. Click Properties for a configured vSwitch.
5. Select a configured VM network under Ports tab of vSwitch Properties window.
6. Click Edit under Ports tab of vSwitch Properties window.
7. Select All (4095) from the drop-down list against VLAN ID (Optional).
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8. Click OK.

MAC Address Collision in a Network

A user notices MAC address collision in a network due to duplicate MAC entries. When the duplicate MAC entry
is detected by AOS-W, connectivity to the Mobility Controller Virtual Appliance is lost. To resolve this issue, refer
to the following KB article. Once the issue is resolved reboot all VMs.

https://kb.vmware.com/selfservice/microsites/search.do?language=en
US&cmd=displayKC&externalld=1024025

Characters Repeating In Remote Console

The user notices unintended keystrokes when typing into a remote console. To resolve this issue, refer to the
following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalld=196

Networks Cards Not Detected

When a new network card is added to the ESXI/ESX host the following symptoms might be displayed:
= The new network card is not recognized by the system.

m The new network card is not listed when you run the command esxcfg-nics -I.

To resolve this issue, refer to the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en
US&cmd=displayKC&externalld=1034782

HP Proliant DL580 Running ESXi 5.5 Is Not Powered On Due To
Memory Leaks

HP Proliant DL580 running ESXi 5.5 will not be powered on due to memory leaks. To resolve this issue, refer to
the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalld=20
85618

Network Interfaces Are Not In The Correct Order

Adding a fifth network adapter that uses vmxnet3 devices changes the PCI bus IDs and also the order of network
interfaces. To resolve this issue, refer to the following KB article:

https://communities.vmware.com/thread/443600

Connectivity Issues Observed When Using Multiple vSwitches

Connectivity issues observed when multiple vSwitches in a VM network. To resolve this issue, refer to the
following KB article:

https://communities.vmware.com/thread/460582
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Appendix

This chapter details additional information required in the current version of the Mobility Conductor. Click the
following links for more information:

m Recommendations for NIC Teaming on a vSwitch

m Increasing the Flash Size on a KVM Hypervisor

m Increasing the Flash Size on a vSphere Hypervisor

m Backing up and Restoring Critical Data

m Datapath Debug Commands

= Implementing Management Interface

= Upgrading a Controller

= Jumbo Frame Support

Recommendations for NIC Teaming on a vSwitch

When creating a vSwitch on the ESXi host, two or more NICs (network adapters) can be configured in the same
vSwitch. To balance the traffic from the VM host to the uplink device since there is more than one NIC configured,
ESXi provides the following configuration options:

Route based on originating port ID.
Route based on IP hash.
= Route based on source MAC hash.

Explicit failover order.

Configuring NIC Teaming

Login to the vSphere ESXi host using WebUI or a vSphere client. This following example is configured through the
WebUI.

1. Login to the ESXi host.

2. Navigate to Networking > Virtual Switches > Add standard virtual switch or right click Networking and
select Add standard vSwitch.

Figure 44 Adding a Standard Virtual Switch

“I% Navigator € localhost.localdomain - Networking

~ [ Host Port groups Physical NICs VMkemel NICS TCPIIP stacks Firewall rules
Manage
Moniter i | @ Refrezh
(51 Virtual Machines (e ~ | Portgroups ~ | Uplinks ©
B storage & vSwitcho 2 1
etwo = ySuitet 1 0
@ Networking . 5
£ Add port group
25 Add standard vSwitch
| Add VMKerel NIC

3. Inthe Add standard virtual switch - New switch window enter the following details:
a. vSwitch Name
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b. Add the required number of uplinks from the Uplink 1 drop-down menu.

c. Under Security, click the Accept radio button for Promiscuous mode and Mac address changes.
4. Click Add. A new vSwitch is created.

Figure 45 New vSwitch

'@ localnostlocaldomain - Networking

Potgroups | Virtualswitches | PrysicalNICs  VMiemelNICs  TCPIPstacks  Firewallules

&2 Add standard virual switch | @ Refiesn (@searcn

Name ~ | Portgroups ~ | Upinks ~ Type v
@8 vSwitchd 2 1 Standard vSwitch

@ vSwitch1 0 Standard vSwitch

@ vSwitch2 1 2 Standard vSwitch

= test uSiten o 1 Standard vSutch

4items
4

Creating a Port Group

1. Navigate to Networking > Port groups > Add port group or right click Networking and select Add port
group.

Figure 46 Adding Port Group

vmware ESXi

°I% Navigator ©) localhost.localdomain - Networking
~ @ Host Port groups | Virtual switches Physical NICs ~ VMkemelNICs  TCP/Pstacks  Firewall rules
Manage
Monitor %3 Add port group | @ Refresh |
(51 Virtual Machines e ~ | Active ports v | VLANID ~ | Type | vswiteh
B storage @ VM Network 1 0 Standard port group 8 vswitcho

€ Networking 1 0 Standard port group
£ Add port 0 51 Standard port group
2 port group
1 51 Standard port group  vsuitch?
E Add standard vSwitch

8 Add VMKkernel NIC

2. Provide a name for the new port group.
3. Add the virtual switch that was configured with NIC teaming to this port group.

4. Ensure the Accept radio button is selected for Promiscuous mode, MAC address changes, and Forged
transmits under Security.

5. Click Add. A new port group is created.
Figure 47 New Port Group

Q Add port group - test port group

Name | test port group

VLAN ID II'

Virtual switch

test vSwitch v

+ Security

Promiscuous mode ® pccept U Reject ) Inherit from vSwitch

MAC address changes ® pccept ) Reject ) Inherit from vSwitch

Forged transmits ® pccept ) Reject ) Inherit from vSwitch

Add | | Cancel

i

Adding the Port Group to a VM Host
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To add the port group to an host, edit the host setting of the Mobility Conductor Virtual Appliance or Mobility

Controller Virtual Appliance.

1. From the Navigator window select Virtual Machines. The list of VMs are displayed.

2. Right-click the VM and select Edit settings or select the VM and click Actions > Edit settings.

Figure 48 Edit VM Settings

3 Create / Register Vi1 | ®F Console Shut down

Virtual machine a
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vme_8x
Guest 0S
Compatibility
Viware Tools
CPUs
Memory

Suspend G’ Refresh v{f} Actions
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~ | Status ~ Guest 0S
s Power
@ Normal Other Linux (64-bit)
Guest 05 -
& Normal Red Hat Enterprise Linux 6 (64-bit)
i Snapshots
[ Console
g Autostart
Red Hat Enterprise Linux 6 (64
ESXi 5.0 and later (VM varsion
s
4 L-j Edit settings
6GE

&, Permissions
[5% Editnotes

[l Rename

© Help

-"j Open in a new window

3. Add the new port group that was created to the VM host.
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Figure 49 Adding Port Group
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» W Network Adapter 4 VM Nebwork v Conneact
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» [l video Card a 2 "'
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4. Click Save.

Preventing Dropping or Looping Broadcast/Multicast Packets
To achieve this you need to make some changes to the NIC teaming policy.

1. From the Navigator window select Networking > Port Groups.

2. Select the new port group that was created and click Edit settings.
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Figure 50 Edit Port Group Settings

vmware ESXi
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3. Click Security and select the Accept radio option to enable Promiscuous mode, MAC address changes,

and Forged transmits.

4. Click NIC teaming and make the following changes:

a. Load balancing option to Use explicit failover order.

b. Network failover detection option to Link status only.

c. Select the Yes radio button for Notify switches and Failback.

d. Select No for Override failover order.
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Figure 51 Edit Virtual Switch Settings

8, Add uplink
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+ Security
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Save
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5. Click Save.

Configuring ReversePathFwdCheckPromisc

In the WebUI

1. From the Navigator window select Manage > System > Advanced settings.

2. Scroll down or use the search bar to go to the Net.ReversePathFwdCheckPromisc option.
3. Select Net.ReversePathFwdCheckPromisc and click Edit option.
4. Inthe Edit option - Net.ReversePathFwdCheckPromisc window update the New value field to 1 and

click Save.

The Net.ReversePathFwdCheckPromisc option is not enabled by default and making changes to this option will be

HOTE

globally applicable on the ESXi.
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In the CLI

[host:] esxcfg-advcfg /Net/ReversePathFwdCheckPromisc

Value of ReversePathFwdCheckPromisc is 0

[host:] esxcfg-advcfg -s 1 /Net/ReversePathFwdCheckPromisc

Value of ReversePathFwdCheckPromisc is 1
[host:]

HOTE

If the value of the ReversePathFwdCheckPromisc configuration option is changed when the ESXi instance is running,

you need to enable or re-enable the promiscuous mode for the change in the configuration to take effect.

Creating a Distributed vSwitch Using vCenter with

LACP Configuration

Follow the steps below to create a distributed vSwitch:
1. Log in to the vSphere web client.

2. From the Home screen, select Networking.

Figure 52 Navigating to the Networking Icon

Plug-ins for Installation
H Watch How-to Videos
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[ Content Libraries b3
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|54 Global Inventory Lists >
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] -9 kS & -
@, Update Manager >
Task Console Event Console VM Storage Customization Update Host Profiles
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=] Task . q
] Tasks Administration
[l Events
{7 Tags & Custom Attributes 8?‘\ iﬁ } 6
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E Saved Searches 3 Configuration Experience Operations
Improvement... Manager

3. Right-click the data center and click Distributed Switch > New Distributed Switch.
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Figure 53 New Distributed Switch
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4. Enter a name for the new switch in the Name and location window. Click Next.
5. Select Distributed switch:6.0.0. Click Next.

| i Select the exact version that is running on the ESXi host for the distributed switch. In this example we are selecting

NoTE Distributed switch:6.0.0, as the setup uses vCenter 6.5 managing ESXi hosts running 6.0.

6. Select the required number of uplink ports Edit Settings page.
Figure 54 Edit Settings

2 New Distributed Switch i ]

+ 1 Name and location Edit settings
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" 2 Selectversion

3 Edit settings —_—
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Metwork /0 Contral. | Enabled |~ ]
Default port group [ Create a default port aroup
Port group name: ‘DF'urIGroup

Back Next Cancel

7. Click Next and review your selections.
8. Click Finish.

Adding ESXi Hosts to the Distributed Switch

Follow the steps below to add ESXi hosts to the newly created distributed switch. These steps will enable
vCenter to add physical ports to the distributed switch.

1. Right-click the newly created distributed switch and select Add and Manage Hosts. Click Next.

2. Inthe Select task window select Add hosts. Click Next.
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Figure 55 Add Hosts
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3. Click New Hosts to add new ESXi hosts for the distributed switch configuration.
4. Select the host from the Select new hosts window and click OK.

| i Select Configure identical network settings on multiple hosts (template mode) to enable similar network

nfigurations on multiple hosts.
NoT config so ple hosts

Figure 56 Select New Hosts

Select new hosts x)

) Incompatible Hosts Q, Filter -
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OK Cancel

5. Click Next. In the Select template host window select a template host to apply its configuration to other
hosts on the switch.

This step will enable you to add physical ports on the ESXi hosts to the distributed switch. Click Next.
6. In the Manage physical network adapters window select a physical network adapter.
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7. Click Assign uplink. The Select an Uplink for vmnic1 window is displayed.

8. Select Uplink 1 for vmnic1 and click OK. Click Next.

In this example we have selected three uplinks when creating the distributed switch. Repeat these steps for the other

vmnic2 and vmnic3.
HOTE

9. Click Apply to all to apply the physical network adapter assignments to all hosts on the switch.

Figure 57 Selecting an Uplink for the Physical Adapter
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10. Click Next in the Manage VMkernel network adapters page.

11. Click Next in the Analyze impact page and Ready to complete page. Click Finish.

Editing Security Properties on the Distributed Port Group

Follow the steps below to modify the security settings on the distributed port group:

1. Select the distributed port group that is created under the distributed switch.

2. Select the Configure tab and click Edit.

3. Select Accept from the Promiscuous mode, MAC address changes, and Forged transmits drop down

lists. Click OK.
Figure 58 Modify Security Settings
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4. Navigate to Hosts and clusters.
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5. Right-click the AOS-W VM that is running on the ESXi hosts to which the distributed switch is configured

and select Edit Settings.

6. Select the distributed port group that was created in the earlier steps as Network Adapter 2.

Connectivity will be restored with correct uplink switch configuration.

Configuring LACP Between the Distributed Switch and Uplink Switch

Follow the steps below to configure LACP between the distributed and uplink switch:
1. From vCenter dashboard, click Networking and select the new distributed switch.
2. Click the Configure tab, and select LACP.

Figure 59 Configure LACP
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3. Click + to add a LAG.

4. In the New Link Aggregation Group window update the following and click OK.
a. Name - Name for the new LAG
b. Number of Ports - 3
c. Mode - Active

5. Select the new distributed port group configuration.

HOTE

By default, uplink ports 1,2, and 3 will be selected for communication as active uplinks. This should be replaced with

the LACP configuration.

6. In the distributed port group page, click the Configure tab and select Edit.
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Figure 60 Edit Port Group Settings
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7. Select Teaming and failover.

8. Using the up and down arrow button move Uplink 1, Uplink 2, and Uplink 3 to Unused uplinks and lag1_
MM1_test to Active uplinks. Click OK.

Figure 61 Assigning Uplink Order
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Mapping LACP Port with Physical NICs

Follow the steps below to map LACP with physical NICs.
1. Right-click the newly created distributed switch and select Add and Manage Hosts. Click Next.
2. In the Select task window select Manage host networking. Click Next.
3. Click Attached hosts and add ESXi hosts to the LACP configuration. Click Next.
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NOTE

HOTE

Select Configure identical network settings on multiple hosts (template mode) to enable similar network

configurations on multiple hosts.

Figure 62 Add and Manage Hosts
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4. In the Select template host window select a template host to apply its configuration to other hosts on the

switch. Click Next.

This step will enable you to add physical ports on the ESXi hosts for LACP. Click Next.
5. Inthe Select network adapter tasks window select Manage physical network adapters. Click Next.

6. In the Manage physical nhetwork adapters window select a physical network adapter.

7. Click Assign uplink. The Select an Uplink for vmnic1 window is displayed.

8. Select lag_MM1_test0 for vmnic1 and click OK.

Repeat these steps for the other vmnic2 and vmnic3.

9. Click Apply to all to apply the physical network adapter assignments to all hosts on the switch. Click Next.
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Figure 63 Adding Ports for LACP
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10. Click Next in the Analyze impact screen. There should be no impact in this window.

Increasing the Flash Size on a vSphere Hypervisor

AOS-W enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the

steps below to increase the size of the flash on the Mobility Conductor Virtual Appliance.
1. Power down the VM.
2. Right click the VM in the vSphere client and click Edit Settings.
3. Click Add in the Virtual Machine Properties window.
4. Click Hard Disk in the Add Hardware window and click Next.

Figure 64 Selecting the Device Type
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5. Select Create a new virtual disk and click Next.
6. Enter a value of the desired disk size and select Thick Provision Lazy Zeroed. Click Next.

Figure 65 Create Disk
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7. Click Next in the Advanced Options window and click Finish.
8. Power on the VM and AOS-W will migrate data from the old hard disk to the new one.

Figure 66 Migrating Data
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9. Confirm if the newly added Hard disk 3 is used by AOS-W. The Hard disk 3 will be listed as /dev/sdc1
and if old hard disk is in use, it will be listed as /dev/sdb1. If the OVF file only contains a single hard disk it be
listed as /dev/sda3.

10. If the new Hard disk 3 is working as expected, the older hard disk can be removed from the VM and
deleted from disk of the vSphere server.

AOS-W recognizes a maximum number of three disks. When a new disk is added, ensure to have a higher Virtual
SCSI device node number, else the disk names will be re-ordered and the data migration process might fail. If an
unused disk is removed, data will be migrated upon a reboot or power up.

Increasing the Flash Size on a KVM Hypervisor

AOS-W enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Conductor Virtual Appliance.

1. To protect the data on the Switch, take a flashback up of AOS-W using scp/ftp/tftp.
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(mm) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
none 3.0G 5.6M 3.0G 0% /tmp
/dev/vdbl 7.7G 452.7M 6.9G 6% /flash
/dev/vda5 1.4G 380.3M  1022.7M 27% /mnt/diskl
/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(mm) [mynode] #backup flash

Please wait while we take the flash backup.......

File flashbackup.tar.gz created successfully on flash.

Please copy it out of the controller and delete it when done.

(mm) [mynode] # copy flash: flashbackup.tar.gz scp: 10.16.9.107 tester flashbackup.tar.gz

2. Access the virt-manager and right click on the VM. Select Shut Down.

3. Click Shut Down for a graceful shutdown of the VM.

4. Add a new VirtlO Disk according to your requirement.

5. Double click the VM and click Show virtual hardware details. Click on Add Hardware.

6. In the Add New Virtual Hardware window click Storage. Enter a desired value for the Create a disk
image on the computer hard drive option and click Finish. A new disk is added.

Figure 67 Adding New Virtual Hardware
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7. Power on the VM. The following message is displayed when AOS-W boots up.
Alcatel-LucentNetworks
AOS-W Version 8.1.0.0 (build 57204 / label #57204)
Built by p4build@lemnos on 2017-04-06 at 20:26:23 PST (gcc version 4.7.2)
(c) Copyright 2017 Hewlett Packard Enterprise Development LP.
[10:18:22]:Starting device manager [ OK]]
Formatting new flash [ OK ]
Forcing filesystem check on new flash [ OK ]
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Mounting new flash [ OK ]

Copying files to new flash [ OK]

8. Once the system boots up, the new disk will show up as vdc and not vdb. The flash will contain the old
data.

(mm) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
none 3.0G 7.5M 3.0G 0% /tmp
/dev/vdcl 15.6G 477.7M 14.4G 3% /flash
/dev/vdab 1.4G 380.3M  1022.7M 27% /mnt/diskl
/dev/vda6 1.4G 380.3M  1022.7M 27% /mnt/disk2

(mm) [mynode] #
9. Power off the VM and select VirtlO Disk2. Click Remove and reboot the controller.
10. Click Yes in the Are you sure you want to remove this device window.

11. The following information is displayed after rebbot and you will be able to use the new disk.

(mm) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
none 3.0G 7.6M 3.0G 0% /tmp
/dev/vdbl 15.6G 477.8M 14.4G 3% /flash
/dev/vda5b 1.4G 380.3M  1022.7M 27% /mnt/diskl
/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #

G AOS-W supports only 3 disks and the size of the new disk thatis added should be more than the current disk size.

HOTE

Backing up and Restoring Critical Data

It is important to frequently back up all critical configuration data and files on the compact flash file system to an
external server or mass storage device. Ensure the following files are backed up regularly:

Configuration data

WMS database

Local user database
Licensing database

Floor plan JPEGs

Custom captive portal pages
x.509 Certificates

Switch Logs

Back Up and Restore Compact Flash in the WebUI

The WebUI provides the easiest way to back up and restore the entire compact flash file system. The following
steps describe how to back up and restore the compact flash file system using the WebUI on the Mobility
Conductor:

1. Click on the Configuration tab.

2. Click Pending Configuration and then Deploy Changes. Pending Changes is visible only when there
changes to be saved, if this option is not visible skip this step.

3. Navigate to the Diagnostics > Technical Support > Backup Flash page.

4. Click Create Backup to back up the contents of the compact flash file system to the flashbackup.tar.gz
file.
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5. Click Copy Backup to copy the file to an external server.

You can later copy the backup file from the external server to the compact flash file system using the file utility
in the Diagnostics > Technical Support > Copy Files page.

6. To restore the backup file to the compact flash file system, navigate to the Diagnostics > Technical
Support > Restore Flash page. Click Restore.

Back Up and Restore Compact Flash in the CLI

The following steps describe the backup and restore procedure for the entire compact flash file system using the
Switch’s command line:

1. Enter config mode in the CLI on the Switch, and enter the following command:

(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the compact flash file system to the
flashbackup.tar.gz file.

(host) [mynode] (config)# backup flash

Please wait while we tar relevant files from flash...
Please wait while we compress the tar file...

Checking for free space on flash...

Copying file to flash...

File flashbackup.tar.gz created successfully on flash.

3. Use the copy command to transfer the backup flash file to an external server or storage device:

(host) [mynode] (config) copy flash: flashbackup.tar.gz ftp: <ftphost> <ftpusername>
<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: flashbackup.tar.gz usb: partition <partition-number>
You can later transfer the backup flash file from the external server or storage device to the compact flash file
system with the copy command:

(host) [mynode] (config) # copy tftp: <tftphost> <filename> flash: flashbackup.tar.gz
(host) [mynode] (config) # copy usb: partition <partition-number> <filename> flash:
flashbackup.tar.gz

4. Use the restore command to untar and extract the flashbackup.tar.gz file to the compact flash file system:
(host) [mynode] (config) # restore flash

Back Up and Restore Configuration in the CLI

The following steps describe the backup and restore procedure for the configuration file system using the
Switch’s command line:

1. Enter config mode in the CLI on the Switch, and execute the following command:

(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the configuration file system to the
configbackup.tar.gz file.

(host) [mynode] (config) # backup config

Please wait while we take the config backup.......

File configbackup.tar.gz created successfully on flash.
Please copy it out of the controller and delete it when done.

3. Use the copy command to transfer the backup configuration file system to an external server or storage
device:

(host) [mynode] (config) copy flash: configbackup.tar.gz ftp: <ftphost> <ftpusername>
<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: configbackup.tar.gz usb: partition <partition-

number>
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You can later transfer the backup configuration file from the external server or storage device to the compact
flash file system with the copy command:

(host) # copy tftp: <tftphost> <filename> flash: configbackup.tar.gz

(host) # copy usb: partition <partition-number> <filename> flash: configbackup.tar.gz

4. Use the restore command to untar and extract the configbackup.tar.gz file to restore the configuration:

(host) [mynode] (config) # restore config

Please wait while we restore the config backup........

Config restored successfully.

Please reload (reboot) the controller for the new config to take effect.

Snapshot

A VMware snapshot is a copy of the virtual machine's disk file (VMDK) at a given point in time. Snapshots
provide a change log for the virtual disk and are used to restore a VM to a particular point in time when a failure or
system error occurs.

A snapshot preserves the state and data of a VM at a specific point in time. A VM provides several operations for
creating and managing snapshots and snapshot chains. These operations let you create snapshots, revert to any
snapshot in the chain, and remove snapshots. For additional information about snapshots refer to the VMware kb
article https://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalld=1015180.

Implementing Management Interface

This sections discusses implementation of the management interface on the Mobility Conductor. It includes the
following:

m Assigning the IP address to the management interface from the CLI

= Ensuring management bound traffic uses the correct interfaces and a default gateway specific to the
management interface

m Protecting the management interface against unwanted traffic and DOS attacks

Once the IP is assigned (manual or dynamic) we should be able to reach the management interface from
anywhere in the network. This requires that we have a default gateway for the management interface. But this
default gateway should not be used for the data routing table of the Switch. So the inherent problem is that we
need to have two default gateways; one for the management interface and the other for the data traffic and the
management traffic should be via the management interface only. This is solved by the use of the iproute2 utility
and having a separate routing table with its own default gateway for the management IP. With this we can ensure
that the management traffic does not leak onto unwanted interfaces.

The management interface is mapped to ethO and is a Linux interface. It is not a part of SOS and does not have
access to the SOS firewall to protect itself. Since the management interface is susceptible to attacks it is
imperative that we should firewall this interface. For this we use the iptables firewall present in Linux. We allow
only ssh (22), telnet(2323) ,tftp(69) and HTTPS(443,4343) traffic on the management interface and also rate limit
traffic to protect Switch from unwanted traffic flood over the network. Initially phase of this feature is implemented
for manually configuring a static IP for management interface from the console. It covers both IPv4 and IPv6
implementation. Most of the functional behavior and implementation are same for IPv4 and IPv6. This feature can
be extended for obtaining IP dynamically from DHCP server in the network in future.

Datapath Debug Commands

Listed below are the commands to view the system statistics of your Switch:
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m Execute the show datapath frame [counters] command to view statistics of the data traffic processed. This
command displays the frame statistics that are received and transmitted from the datapath of the Switch.
Allocated frames indicate buffers allocated at any given point of time. A constant increment in the buffer
indicates a buffer leak.

The following example displays statistics of data traffic processed.

(host) #show datapath frame counters

Fo— f——-—-— - +
lsuM/ | | | |

|[CPU | Addr | Description Value |

Fomm - Bt et ittt e T +
| | [00] | Allocated Frames 3155 |

| | [03] | Unknown Unicast 127 |

| | [04] | IPv6 Unknown Unicast 5 |

| G | [00] | BPDUs Received 28 |
Fmm et ———— Rttt i ettt D Lt +
m Execute the show port stats command to view the traffic received/transmitted through gigabit ports using the
datapath.
The following example displays the port statistics.
(host) #show port stats
Port Statistics

Port PacketsIn PacketsOut BytesIn BytesOut InputErrorBytes OutputErrorBytes CRCErrors
RxNoMbuf

GE 0/0/0 6179766 46516 1192249262 3446810 0 0 0 0
GE 0/0/1 179 166996 14782 5019706 0 0 0 0
GE 0/0/2 00000000
m Execute the show datapath heartbeat stats command to monitor the health of the systems. Heartbeats are

sent from the control plane to the datapath every second. The packets pass through the datapath CPUs and
return to the control plane in one second. If the load on the system increases or there is a CPU lock there is a
possibility of the heartbeat being missed. If this recurs 30 times consecutively the Switch reboots. The
heartbeat probe introduced in this release, sends out a probe when two consecutive heartbeats are missed
and also measures the actual time taken for the packets to pass through the datapath CPUs and return to the
control plane.
The following example displays the heartbeat statistics.
(host) #show datapath heartbeat stats
Sibyte HeartBeat Stats:

Total HB sent: 42686

Total HB send errors: 0

Current HB send errors: 0 (max:30)

HB send errors high water-mark: 0
Sibyte Probe Stats:

Total probes sent: 0
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Last probe sent @ 0:00:00.000

Last probe rcvd @ 0:00:00.000
Execute the show datapath dpdk [mempool-stats | ring-stats] command to view the DPDK mempool and
ring statistics. Since the size of the mempool and ring may vary based on the system template this command
identifies the size of the structures used.
The following example displays DPDK mempool and ring statistics.
(host) #show datapath dpdk mempool-stats
DPDK Memory Pool Statistics Table

mPoolName mPoolAddr Flags phyAddr Size hdrSize eltSize tSize priDataSize success bulk
success _objs fail bulk fail objs cPoolCount

log history 0x2aaaaa802080 0 0x0xa%9002080 512 64 2048 0 0 0 0 O O 479
mbuf pool 0x2aaa36200000 0 0x0xa9400000 65536 64 4032 0 0 0 0 0 O 62935
msg 0x7fecd6700080 0 0x0x24700080 1024 64 40 24 0 0 0 0 O 1024

(host) #show datapath dpdk ring-stats

DPDK Ring Statistics Table

Flags: Flag - set for single producer or consumer

Used - number of entries in a ring

Freed - number of free entries in a ring

QThreshold - Enqueque Threshold

nQSuccessBulk - Successful enqueues number

nQSuccessObjs - Objects successfully enqueued

nQFailBulk - Failed engqueues number

nQFailObjs - Objects that failed to be enqueued

dQSuccessBulk - Sucessful dequeues number

dQSuccessObjs - Objects successfully dequeued

dQFailBulk - Failed dequeues number

dQFailObjs - Objects that failed to be dequeued

RingName RingAddr Flag Used Freed QThreshold nQSuccessBulk nQSuccessObjs nQFailBulk
nQFailObjs dQSuccessBulk dQSuccessObjs dQFailBulk dQFailObjs

MP log history 0x2aaaaa800000 0 479 544 0 0 0 0 0 0 0 0 O
MP mbuf pool 0x7fecd6600000 0 62908 68163 0 0 0 0 0 0 0 O O
core-0-low Ox2aaaaa98ab5c0 2 0 1023 0 0 0 0 0 0 0 0 O
core-0-high 0x2aaaaa9%98c640 2 0 1023 0 0 0 0 0 0 0 O O
core-l-low Ox2aaaaa98e6c0 2 0 1023 0 0 0 0 0 0 0 0 O
core-1l-high 0x2aaaaa990740 2 0 1023 0 0 0 0 0 0 0 0 O
core-2-low Ox2aaaaa9927c0 2 0 1023 0 0 0 0 0 0 0 0 O
core-2-high 0x2aaaaa994840 2 0 1023 0 0 0 0 0 0 0 0 O

MP msg 0Ox2aaaaa%9968c0 0 1024 1023 0 0 0 0 0 0 0 0 O

Execute the show datapath utilization command to view the CPU utilization of all the datapath CPUs
(SP/FP).

The following example displays datapath CPU utilization statistics.
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If the CPU speed is more than 2.1 GHz, data displayed under the 64 Secs option is invalid, but valid only for 1 Sec

NoTe and 4 Sec options. Counter inconsistency is only for CPUs with speed more than 2.1 GHz.

(host) #show datapath utilization
Datapath Network Processor Utilization
—————— -t ——————+
| Cpu utilization during past |
Cpu | 1 Sec 4 Secs 64 Secs |
0

2 | 0
m Execute the show cpuload [current] command to view the Switch's CPU load for application and system

processes. Use the current option to check the output of the top two UNIX commands.

The following example shows that the majority of the Switch’s CPU resources are not being used by either the

application (user) or system processes.

(host) #show cpuload

user 6.9%, system 7.7%, idle 85.4%

The following example displays the summary of system (CPU) load. When the current option is used, it

displays detailed information of the CPU load for each process.

(host) #show cpuload [current]

top2 - 05:09:29 up 2 days, 9 min, 0 users, load average: 0.00, 0.01, 0.05

Tasks: 132 total, 2 running, 130 sleeping, 0 stopped, 0 zombie

Cpu(s): 2.5%us, 1.5%sy, 0.0%ni, 96.0%id, 0.0%wa, 0.0%hi, 0.0%si, 0.0%st

Mem: 7915932k total, 2817304k used, 5098628k free, 2744k buffers

Swap: Ok total, Ok used, Ok free, 193244k cached

PID USER PR NI VIRT RES SHR S $CPU %MEM TIME+ COMMAND

3462 root 20 0 2134m lém 7772 S 26 0.2 744:48.18 sos.shumway.elf

3654 root 20 0 56112 5856 4732 S 4 0.1 40:48.87 gsmmgr

3503 root 20 0 0 0 0 R 2 0.0 63:24.05 kni single

1 root 20 0 8340 676 572 S 0 0.0 0:00.92 init

2 root 20 0 0 0 0 S 0 0.0 0:00.00 kthreadd

3 root 200 0 0 0 S 0 0.0 0:00.22 ksoftirgd/0
5 root 20 0 0 0 0 S 0 0.0 0:02.02 kworker/u:0
6 root RT 0 0 0 0 S0 0.0 0:00.00 migration/0
7 root RT 0 0 0 0 S 0O 0.0 0:00.00 migration/1
8 root 20 0 0 0 0 S 0 0.0 0:01.94 kworker/1:0
9 root 2000 0 0 S0 0.0 0:07.79 ksoftirgd/1l

10 root 20 0 0 0 O
11 root RT 0 0 0 O

0 0.0 0:01.26 kworker/0:1
0 0.0 0:00.00 migration/2
12 root 20 0 0 0 O 0 0.0 0:01.08 kworker/2:0
13 root 20 0 0 0 O 0 0.0 0:05.80 ksoftirgd/2
14 root 0 =20 0 0 0 S 0 0.0 0:00.00 cpuset

15 root 0 =20 0 0 0 S O 0.0 0:00.00 khelper

16 root 0 =20 0 0 0 S 0 0.0 0:00.00 netns

S
S
S
S
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Upgrading a Switch

Follow the steps below to upgrade the Switch. You can upgrade the OS on the Switch either through WebUI or
through the CLI. The following methods can be used to upgrade the OS on the Switch:

m TFTP

s FTP

s SCP

m Local File (This option is available while upgrading through WebUI)

Be sure to back up the Switches as described in Backing up and Restoring Critical Data.

In the WebUI:

1. In the Mobility Conductor node hierarchy, navigate to Configuration > Upgrade > Software
Management.

2. Choose the upgrade method.
3. If you are using TFTP, FTP, or SCP for upgrade enter the server IP address.
4. Enter the image file name.
5. Choose the partition to upgrade.
6. Select Yes to Reboot Controller After Upgrade.
7. Select Yes to Save Current Configuration Before Reboot.
8. Click Upgrade.
Inthe CLI:
Execute the following commands on the CLI to upgrade the OS:

For TFTP: (host) [mynode] (config)# copy tftp: <TFTP server IP address> <image file name>
system: partition <0 or 1>

For FTP: (host) [mynode] (config)# copy ftp: <FTP server IP address> <username> <image file
name> system: partition <0 or 1>

For SCP: (host) [mynode] (config)# copy scp: <SCP host IP address> <username> <image file
name> system: partition <0 or 1>

Once the image is uploaded in the flash, save the configuration and reload the Switch.

If the following error message is displayed, follow the steps above to reload the OS on both partitions.
(host) [mynode] (config)# show image version

Ancillary image stored on flash is not for this release
KA AR AR A A A AR A A AR A A A AR A A A A AR A A AR A A A A A AR KR A AR A A AR A AR A A AR AN AR A AR A A AR A AR A A AR Ak K

* WARNING: An additional image upgrade is required to complete the *
* installation of the AP and WebUI files. Please upgrade the boot *

* partition again and reload the controller. *
khkhkkhkhkkhkhkhkhkhkhkhkhhhkhhhkhkhhhhkhhkhhkhhhhhhhkhkhhhkhhhkhhkhhhhkhkhkkhhkhkhhkhrkhhkhkhkhkhrhkhrkhkhrkhhxkhx

Gracefully Shutting Down AOS-W VMs

It is important to gracefully shutdown the guest AOS-W VM'’s to avoid database corruptions and other related
issues. The following steps describe the process to perform a graceful shutdown in the VMware ESXi and KVM
hypervisor.

In the VMware ESXi Hypervisor

1. Right click the VM in the vSphere client.
2. Click Power > Shut Down Guest or Power > Restart Guest.
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In the KVM Hypervisor

In the KVM hypervisor peform a graceful shutdown by either clicking click Shut Down or Reboot.

Figure 68 Graceful Shutdown in KVM Hypervisor
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Jumbo Frame Support

Jumbo frames are the data frames that are larger than 1500 bytes and includes the Layer 2 header and frame

check sequence. Jumbo frames functionality can be configured on the following and can support up to 9216 bytes

of payload:

= OmniAccess Mobility Controllers (OAW-40xx Series Switches, OAW-4x50 Series Switches, and Mobility
Controller Virtual Appliances)

= Mobility Conductor (Mobility Conductor Virtual Appliance and hardware Mobility Conductor)

In centralized deployments, frames that are more than 1500 bytes in size are generated from the AP to the
managed device during encryption and enabling AMSDU. Therefore, whenever the AP associates to the
managed device, jumbo frames are used to get the highest network performance. If this functionality is not
supported, the data frames gets fragmented, which reduces the overall throughput of the network and makes the
network slow.

AOS-W supports jumbo frames between 11ac APs, OAW-40xx Series, OAW-4x50 Series Switches, and x86 platforms
such as Mobility Controller Virtual Appliances, Mobility Conductor (Mobility Conductor Virtual Appliances, and
hardware Mobility Conductors.

Jumbo frames are not supported on Mobility Controller Virtual Appliances and Mobility Conductor Hardware
Appliances running on Windows Hyper-V.

You can enable the jumbo frame support in the following scenarios:
= Tunnelnode: In atunneled node deployment, the wired clients connected on the tunneled nodes can send
and receive the jumbo frames.

m L2 orL3 GRE tunnels: When you establish a GRE tunnel between two managed devices, the clients on one
managed device can send and receive jumbo frames from the clients on the other managed device on enabling
jumbo frames.

m Between wired clients: In a network where clients connect to the managed device with jumbo frames
enabled ports can send and receive the jumbo frames.

m  Wi-Fitunnel: A Wi-Fi tunnel can support an AMSDU jumbo frame for an AP (the maximum MTU supported is
up to 9216 bytes).

AMSDU is not supported on x86 platforms.
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Limitations for Jumbo Frame Support

This release of AOS-W does not support the jumbo frames for the following scenarios:

m |Psec, IPIP, and xSec.

m |Pv6 fragmentation or reassembly.

Configuring Jumbo Frame Support

You can use the CLI to configure the jumbo frame support.

To enable the jumbo frame support globally and to configure the MTU value:
(host) [mynode] (config) #firewall jumbo mtu <1789-9216>

You can configure the MTU value between 1789-9216. The default MTU value is 9216.

To enable jumbo frame support on a port channel:
(host) [mynode] (config) #interface port-channel <id> Jjumbo

To enable jumbo frame support on a port:

(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port> jumbo

Viewing the Jumbo Frame Support Status

Execute the following command to view the global status of the jumbo frame support:

(host-vmc) [mynode] #show firewall

Execute the following command to view the jumbo frame status on a port:

(host-vmc) [mynode] #show interface gigabitethernet <slot>/module>/<port>

Execute the following command to view the jumbo frame status on a port channel:

(host-vmc) [mynode] #show interface port-channel <id>

Enable/disable Jumbo Frame Support Globally and Configure MTU Value

(host) [mynode] (config) #firewal

(host) [mynode] (config-submode) #jumbo ?

mtu MTU of Jumbo frames on this platform (when enabled)
<cr>

(host) [mynode] (config-submode) #jumbo mtu ?
<1789-9216> MTU for Jumbo frames

(host-vmc) [mynode] (config-submode)#jumbo mtu 9216
(host-vmc) [mynode] (config-submode)#no Jjumbo

Enable/disable Jumbo Frame Support on a Port

(host-vmc) [mynode] (config) #interface gigabitethernet 0/0/0
(host-vmc) [mynode] (config-submode) #jumbo
(host-vmc) [mynode] (config-submode)#no jumbo

Enable/disable Jumbo Frame Support on a Port Channel

(host-vmc) [mynode] (config) #interface port-channel 0
(host-vmec) [mynode] (config-submode) #jumbo
(host-vmc) [mynode] (config-submode)#no jumbo

Appendix |
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